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TUTORIAL 1
Teknik Fotogrametri dan UAV

Pemetaan digital adalah suatu proses pembuatan peta dimana proses pengumpulan,
pengolahan, penyimpanan dan penyajian datanya dilakukan secara digital. Pemetaan melibatkan
aspek perangkat keras, perangkat lunak dan personil untuk melakukan keseluruhan proses
tersebut.

Proses pengumpulan data dapat dilakukan dengan beberapa teknik yaitu: pengukuran
teristris, pengukuran dengan Global Positioning System (GPS), fotogrametris dan remote sensing
dimana data yang dikumpulkan dapat berupa data digital maupun hardcopy. Proses pengolahan
data merupakan proses untuk mengolah data-data hasil pengumpulan atau pengukuran di
lapangan menjadi data yang dapat disajikan sesuai dengan kebutuhan pengguna sedangkan
proses penyajian data merupakan proses untuk menampilkan data hasil pengolahan menjadi
sumber informasi dalam proses pengambilan keputusan sedangkan proses penyimpanan data
merupakan proses perekaman data ke dalam media penyimpanan seperti server, hardisk maupun
DVD room.

1.1. Teknik Fotogrametri

Fotogrametri merupakan ilmu, seni dan teknik untuk memperoleh data dan informasi
tentang suatu objek atau fenomena melalui proses pencatatan, pengukuran dan interpretasi foto
udara sedangkan pemetaan fotogrametri merupakan proses pemetaan objek - objek di
permukaan dengan menggunakan foto udara yang bertampalan (overfap) sebagai media, dimana
proses interpretasi dan pengolahan geometri dilakukan untuk menghasilkan peta orthofoto dan
peta garis. Dalam pembuatan peta orthofoto dan peta garis dengan geometri dan skala yang
benar maka dilakukan proses restitusi foto udara secara tunggal (rektifikasi) maupun secara
stereo (orthofoto), dimana proses ini memerlukan titik-titik referensi yang diketahui koordinatnya.

Dewasa ini, proses pemotretan foto udara dilakukan dengan menggunakan UAV
(Unmanned Aerial Vehicle) dengan kamera digital ber GPS yang dapat dikontrol melalui piranti
lunak perencanaan pemotretan (lihat Gambar 1.1). Proses pemotretan tersebut menghasilkan
foto udara format kecil (Small Aerial Photo Format) bertampalan dengan masing-masing foto
berkoordinat untuk selanjutnya disusun menjadi mozaik foto (lihat Gambar 1.2). Kemudian SAPF
yang dihasilkan diolah dengan menggunakan piranti lunak pengolahan fotogrametri seperti
Summit Evolution, Pix4D atau Agisoft Photoscan. Proses pemetaan fotogrametris secara singkat
dapat dilihat pada Gambar 1.3.
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Gambar 1.1. Proses Perencanaan Jalur Terbang

Gambar 1.2. Proses Pemotretan dan Mozaik Foto
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Gambar 1.3. Proses Pemetaan Fotogrametri

1.2. Pengenalan UAV

Unmanned Aerial Vehicle (UAV), atau pesawat tanpa awak (nir awak) adalah sebuah
mesin terbang yang dikontrol melalui pengendali jarak jauh atau pesawat yang terbang secara
mandiri berdasarkan program yang dimasukkan ke dalam pesawat sebelum terbang. Pesawat ini
bisa digunakan kembali dan mampu membawa muatan baik senjata maupun muatan lainnya.

Pemanfaatan UAV dibidang pemetaan sangat menjanjikan, antara lain: pemetaan daerah
irigasi, pemetaan di daerah perkotaan, pemetaan untuk penyajian model 3 dimensi yang
memungkinkan pengguna untuk melakukan perhitungan volume material atau pemetaaan

berskala besar lainnya.



1.2.1. Cara Pemotretan UAV untuk Pemetaan

Pemanfaatan UAV untuk pemetaan dapat dilakukan melalui kombinasi antara kontrol
jarak jauh maupun melalui program yang dimasukkan ke dalam pesawat. Namun, sebelum
melakukan proses pengambilan gambar terdapat beberapa hal yang harus diperhatikan, antara
lain:

1. Posisi kamera harus vertikal (tegak lurus permukaan bumi)

2. Ketinggian terbang pesawat, akan berpengaruh terhadap kedetilan objek yang dapat
diidentifikasi di dalam foto udara yang dihasilkan

3. Overlap antar foto, yang terbagi atas ovelap depan (antar foto dalam jalur terbang) dan
overlap samping (antar foto antar jalur terbang)

4. Ketersediaan sumber tenaga selama proses pemotretan yang telah diprogram
berlangsung

1.2.2. Setting UAV/Drone

Persiapan UAV untuk pemetaan meliputi dua tahapan, yang terbagi dalam persiapan UAV
dan koneksi piranti lunak ke UAV. Dalam modul ini proses persiapan UAV disusun dengan
menggunakan DJ]I Phantom 3 Std.
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Gambar 1.4. Perlengkapan DJI Phantom 3 Standard

Persiapan
Tahapan persiapan meliputi persiapan kamera, pemasangan propeller dan pengecekan daya
baterai serta pemasangan baterai
1. Lepaskan Pengaman Gimbal dan Kamera
2. Tarik pengaman kamera dengan cara menggesernya ke sebelah kanan. Kemudian
lepaskan pengaman kamera depan.



3. Pasang baling-baling (propeller) sesuai dengan tanda yang ada pada baling-baling (hitam
atau putih). Pada bagian atas baling-baling terdapat 2 tanda yaitu putih dan hitam yang
masing-masing tanda tersebut menunjukkan bahwa pemasangan baling-baling harus
sesuai pada tempatnya di bagian drone. Pastikan pemasangan sudah sesuai dengan
tandanya untuk menghindari lepasnya baling-baling pada saat terbang
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4. Pasang baterai. Sebelum dipasang pada badan pesawat, harus dilakukan pengecekan
daya untuk menghindari kehilangan daya pada saat wahana terbang. Tekan pada tombol
satu kall untuk mengetahui indikator baterai. Untuk kepentingan pemetaan pastikan

baterai terisi penuh, kemudian pasang batere pada wahana.
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Koneksi Piranti Lunak ke UAV
1. Check Baterai Remote Control (RC), Baterai Tablet / Ipad, dan Baterai UAV (Usahakan

semuanya dalam keadaan penuh)

2. Nvyalakan remote control terlebih dahulu sebelum menvyalakan baterai UAV, dan pasang

Tab/Ipad pada tempatnya. Pastikan kedua toggle pada posisi kebawabh.

back and forth multipla
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3. Setelah remote dinyalakan, untuk menghubungkan dengan Tab/Ipad, nyalakan fasilitas
wifi pada perangkat Tab/Ipad dan koenksikan dengan wifi Phantom 3 Standar (Phantom
3 Standar menggunakan fasilitas wifi untuk koneksi dengan perangkat Tab/Ipad)
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4. Aktifkan aplikasi DJI-GO pada perangkat Tab/Ipad untuk menghubungkan perangkat UAV
dengan Tab/Ipad

6. Setelah terkoneksi, perhatikan beberapa indikator yang tampil di layar.

-
. ’
S0 Jaks QL andis Toggle Photo/Video Mode s

Shutter/Record gl

Home Point Settings,

. l Playback
Clear Fli ; ht Route Advanced Camera Settings
L ]
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GPS Status ] ] I |
Flight Mode Aircraft Stato

Aircraft Battery Power

“u

General Settings

- e

Yellow tips are buttons, white tips are not

Jika sudah masuk tampilan aplikasi DJI GO, pastikan anda memperoleh keterangan Safe
to Fly (GPS) dengan warna kotak Aman untuk terbang yakni berwarna hijau bila anda
sedang berada di luar Ruangan (Outdoor).

Safe tofly (GPS)

Jika wahana drone akan digunakan untuk mengambil gambar pemetaan menggunakan
aplikasi Drone Deploy, pada tampilan Advance Setting, posisi Multiple Flight Mode harus
dalam keadaan aktif.

Safe to fly (GPS) @ .l m

SC 100 500 EV+0.7 [&° 3,182 RAW LOG

Advanced Settings

Multiple Flight Mode

Failsafe Mode

Smari Go Homa

Enter fight data




1.2.3. Setting Drone Deploy

Aplikasi Drone Deploy digunakan untuk merencanakan penerbangan dan pemotretan
secara otomatis tanpa campur tangan pilot.
1. Unduh dan Install aplikasi Drone Deploy yang terdapat di App Store atau Android App
sesuai dengan perangkat yang anda pakai (Tablet atau Ipad).
2. Jalankan aplikasi Drone Deploy yang telah anda install

3. Buat akun untuk bisa masuk ke aplikasi Drone Deploy

Login

W2 Sumanwath Google

4. Setelah masuk kedalam aplikasi Drone Deploy, klik menu Setfting. Pada pilihan Max
Altitude, pilih ketinggian maksimum pada angka 300 m, atau disesuaikan dengan
ketinggian yang diinginkan. Setelah selesai, kembali ke menu semula.

10
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Metric
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Password

Current Plan:

5. Untuk memulai membuat rencana terbang kawasan yang akan dipetakan, klik Plan a New

a o

Settings  Support

z

+ Plan a New Flight

6. Pada tampilan selanjutnya lakukan beberapa langkah berikut
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B Area
@ Duration bectares
2:48 minutes
= Resolution
3.2 cm/px
2= Altitude

—a Can.

Y Flight Direction

- D

Maka Available Offline »

0 of max 10 plans selected for offline flight

4 Advanced E

-

Don't own a drone? Test the simulator

Plan Name: Masukkan nama untuk rencana terbang

Duration: menunjukkan waktu yang diperlukan oleh wahana drone untuk
menyelesaikan pengambilan gambar peta daerah yang telah ditentukan

Area: menunjukkan luas daerah yang dipetakan

Resolution: menunjukkan besaran pixel hasil gambar yang dipetakan

Altitude: masukkan ketinggian wahana drone untuk mengambil gambar daerah yang
akan dipetakan

Flight Direction: Menunjukkan arah terbang wahana drone.

Advance: Sideplap dan Frontlap menunjukkan besaran overlapping setiap gambar
yang diambil oleh wahana drone. Penjelasan lengkapnya pada gambar berikut.

12



Advanced

Sidelap
—_— e

Frontlap
—e

Starting Waypoint

@

Automatic Camera Settings

Orbit at End of Mission

0% overiap

20% overiap

/0% overiap

F. Lokasi yang akan dipetakan sudah muncul otomatis pada saat aplikasi Drone Deploy

dijalankan. Area yang akan dipetakan ditandai dengan area berwarna biry,

sedangkan garis-garis hijau menunjukkan jalur terbang wahana drone.

G. Setelah semua selesai, klik gambar disket pada pojok kanan bawah untuk menyimpan

semua settingan.

Raden'Pat

7. Pada DJI Phantom 3 Standar, koneksi antara wahana drone dengan perangkat
tablet/Ipad dihubungkan dengan menggunakan fasilitas Wifi, sehingga perangkat
Tablet/Ipad tidak dapat terkoneksi dengan internet pada saat yang bersamaan. Oleh
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sebab itu gunakan fasilitas Offline untuk mengunduh wilayah yang akan dipetakan. Pada
tampilan dashboard pilih menu Make Available Offline pada file yang telah dibuat diatas.

L Plar a New Flight

I 2 Make Availabie Offline

T Copy

+ W Delate

Home
Untitled Plan

0 Shutter priority + Auta.
Loy 16U 17

Setelah file selesai di unduh hubungkan kembali wahana drone dengan perangkat
Tablet/Ipad menggunakan fasilitas Wifi.
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Setelah semua siap, drone mulai dijalankan dengan menekan gambar pesawat pada
pojok kanan bawah Drone Deploy.
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TUTORIAL 2
Pengolahan Data UAV

Data hasil pemotretan dengan UAV dapat diolah menjadi mosaik foto dan DEM dengan
menggunakan piranti lunak Agisoft Photoscan melalui beberapa tahapan antara lain: import foto
dan rekonstruksi jalur terbang, align foto, pembangunan dense point, pembangunan model 3D,
pembuatan teksture, pembuatan DEM dan Orthofoto.

2.1. Konfigurasi Software Agisoft Photoscan

Untuk memaksimalkan kemampuan komputer dalam mengolah foto udara hasil survei,
konfigurasi GPU (VGA) dan CPU (Processor) perlu diatur terlebih dahulu. Secara umum,
penggunaan GPU lebih diutamakan daripada penggunaan CPU. GPU yang mensupport CUDA
(Video Card NVIDIA) pada umumnya lebih baik dibanding dengan GPU yang hanya mendukung
OpenCL (Intel atau AMD on-board Graphic).

Menu pengaturan GPU dapat diakses dari Menu Tools > Preferences >GPU/OpenCL.
Centang pada pilihan GPU yang mendukung CUDA apabila tersedia. Selain itu, pada beberapa
versi agisoft juga terdapat slider pengaturan CPU yang digunakan, konfigurasi optimal untuk CPU
adalah sesuai dengan jumlah GPU yang diaktifkan.

H Untitled = Agiscft PhotoScan Professional
B PhotoScan Preferences w File Edt View Worddflow Model Phote Ortho Tools  Help
= H ! v - - v Markers LA
Gerersl  GPU Netwark Apperance  Mawgatonm  Advanced Workenacs Tie Points 4
GPU devices: o i M x Dense Cloud L3
&4 GeForce GTX 960 (B compute units @ 1177 MHz, 2048 ME) CUDA Workspace (0 chunles, O cameras) Mesh r
Orthomozsic 3
Lems »
H PhotoScan Preferences b4 3

Ganersl CperCL Advancad HNatwork Appeararce

Active CPU cores:

' wa ¢ RunScript.. TR
OpeniCL devices: Wi Preferences...
-
[#] GeForce GTX 1050 Ti (6 Cores @ 1620 MHz, 4096 ME
[ Intel{R) UHD Graphics 530 (24 Cores @ 1100 MHz, 3218 MB)
B PhotoScan Preferences X
Genersl G MNetwork A . —_— Acanced

Note: G a GPU devices:
refnement, = -
[ use ciu ] GeForce 930MX (3 compute units @ 1019 MHz, 2048 MB) CUDA

[ Intel(R) HD Graphics 520 (24 compute units @ 1000 MHz, 158... OpenCL

Wihan using OpenCL. please deactvate cne CPU cors for sach GPU
in use for optesl performance.




Selain pengaturan GPU, terdapat dua konfigurasi lain yang dapat mempercepat proses
pengolahan foto, terutama apabila akan dilakukan pengulangan atau modifikasi dari rangkaian
pemrosesan foto. Konfigurasi tambahan dapat diakses dari Menu Tools > Preferences >
Advanced. Disini terdapat dua konfigurasi tambahan yang penting, yaitu pilihan Keep Key
Points dan Keep Depth Maps. Pilihan Keep Key Points sangat membantu mengurangi beban
pemrosesan apabila pada suatu project pengolahan foto perlu ditambahkan foto baru setelah
proses pengolahan berjalan. Sedangkan pilihan Keep Depth Maps berguna untuk mengurangi
waktu pemrosesan apabila dilakukan pembangunan ulang pada pembangunan Dense Point Cloud
atau pembangunan Mesh.

[ PhotoScan Preferences >

General GPU Metwork Appearance Navigation Advanced

Project Files

- E

[ keep key paints
[ Kemp depth maps

LI Store absolute mage paths

Export / Impart

[ Strip fle extensions from camera labels

[ Load camera calibration from XMP meta data

[[] Load camera orientation angles from XMP meta data
[[] Load camera locaton acauracy from XMP meta data
[[] Load GPS/INS offset from XMP meta data
Miscellaneous

£~ Enable VBO support:

[[] Enable mipmap generation

] Enable performance opbmization

[1 Enable mutthread image loading

[l Enable rich Python console

[ attach markers to shape vertices

[C] Refine marker projections based on image content

B uise vasiility consistent mesh generation method (experimental)

2.2. Import Foto dan Rekonstruksi Jalur Terbang

Tahap import foto dan rekonstruksi jalur terbang merupakan tahap paling awal, dimana
disini kumpulan foto hasil survei dibuka di dalam software agisoft dan direkonstruksi urutan umum
foto menurut jalur terbang secara otomatis. U ntuk menambahkan foto udara kedalam workspace,
pada toolbar menu anda dapat klik Workflow > Add Photos
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2.3. Kalibrasi Kamera

Kalibrasi kamera di dalam software Agisoft dilakukan untuk memperbaiki kesalahan akibat
keberadaan rolling shutter. Rolling shutter secara umum dapat didefinisikan sebagai cara kamera
merekam obyek permukaan bumi. Kamera dapat merekam secara serentak (disebut dengan
global shutter), atau melakukan perekaman per baris (seperti cara perekaman mesin fotokopi).
Perekaman per baris ini disebut rolling shutter. Untuk perekaman foto dengan obyek bergerak
seperti UAV, rolling shutter dapat menyebabkan pergeseran posisi antar baris piksel foto,
sehingga dapat berpengaruh pada kualitas hasil pengolahan foto.
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Dari berbagai produk UAV yang telah dikembangkan dewasa ini, terdapat tipe UAV yang
masih menggunakan kamera dengan sistem rolling shutter, namun banyak juga yang telah
mengimplementasikan global shutter. Oleh karena itu, operator UAV perlu melakukan
pengecekan apakah kamera yang dipakai menggunakan sistem global atau rolling shutter. Untuk
kamera yang menggunakan sistem rolling shutter, kalibrasi dapat dilakukan sebelum proses
alignment foto.

Untuk melakukan kalibrasi, langkah yang dilakukan sebagai berikut:

1. Dari menu Tools > Camera Calibration.

hotoScan Professional

[flow Model Photo Orho Tools Help

IEd. B R - Markers v 4
Tie Points *

x Dense Cloud

- Mesh

6487 cameras)
Orthamasaic 0

bmeras, 154,485 points) [R]
neras) i Lot
1o Camera Calibration..

#* Optimize Cameras...
Calibrate Reflectance...
Calibrate Colors...
5et Primary Channel_.

4 SetBrightness.,

"9 SenRaster Transtorm..
Generate Contours.

2. Centang pilihan Enable Rolling Shutter Compensation.

B camera Calibration o %
[ Fr.;-' 20 (4.7 mm Camera type: Frama -
= 1184 images, 4000x2250 pix Poeal siza (mm): 0.00170421 ® |0,00170421 ]

FC220 (4.7 mm) Faocal length (mm): 4.7 ]

1668 images, 4000x3000 pix 'i Enable rolkng shutter compansation || Film camera with fidwcial marks

Initial Adjusted Bands GPS/THS Offset
Type: | Aulo ¥ ] Fix calibration
f: |(2757.88012
o (0 bi: o

" b

2.4. Align Foto

Align photo dilakukan untuk mengidentifikasi titik—titik yang ada di masing—masing foto
dan melakukan proses matching titik yang sama di dua atau lebih foto. Proses align photos akan
menghasilkan model 3D awal, posisi kamera dan foto di-setiap perekaman, dan sparse point
clouds yang akan digunakan di tahap berikutnya.
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1. Dari Menu Workflow - Align Photos.

H Untitled* — Agisoft PhotoScan
File Edit View Workflow Tools Photo Help

B :,] % AddPhotos... b AW
o = o AddFolder... del
BRI T
T Workspace (1 ck Build Dense Cloud,
Chunk 136

Batch Process...

2. Muncul pilihan Accuracy dan Pair Preselection. Untuk accuracy, anda bisa memilih
berdasarkan kebutuhan. Untuk kajian awal seperti melihat cakupan overlap hasil foto
selama survey, gunakan accuracy low, sedangkan untuk tahap produksi citra yang
sebenarnya, gunakan accuracy highest. Sedangkan pilihan Pair Preselection digunakan
untuk membantu Agisoft dalam proses aligning photos, Jika foto mempunyai koordinat
bawaan dari GPS Kamera UAV (geotagged), gunakan mode Reference. Sedangkan jika
foto tidak mempunyai koordinat bawaan (ungeotagged), gunakan mode Generic atau
bisa juga dibandingkan antara keduanya untuk melihat mana yang lebih efektif. Klik OK.

H Align Photos b B Align Photos X

¥ General
Accuracy:

Pair preselection:

b Advanced

High

[ Generic
| Disabled

|Reference
Cancel

¥ General

Accuracy:

b Advanced

Pair preselection:

[High ¥

| Highest

| Medium |

{Low |

| Lowest |
Carcel

Akurasi memiliki 5 tingkatan dari terendah sampai tertinggi, (lowest sampai highest), untuk
memprediksi tingkat akurasi posisi kamera yang lebih akurat, sedangkan pair perselection
terdapat 3 pilihan, generic, disabled, dan reference.

e Generic digunakan untuk mempercepat pengolahan hasil foto
e Disabled digunakan untuk memproses foto tanpa acuan
e Reference digunakan jika foto memiliki acuan referensi, seperti GCP/Koordinat.

Pada menu advance terdapat key dan tie point limit, jika ingin membatasi point cloud yang
terdeteksi bisa menggunakan batasnya seperti 4000, tetapi jikka membatasi maka berikan
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nilai 0. Jika tidak dibatasi memungkinkan pencarian piksel yang bertampalan semakin banyak.

Adaptive camera model fitting boleh dicentang boleh tidak, tidak terlalu berpengaruh

terhadap hasil.

3.

Proses align photos akan mulai dijalankan. Waktu pemrosesan bergantung pada pilihan
accuracy dan kemampuan Hardware dari komputer yang digunakan. Makin tinggi
accuracy makin lama waktu pemrosesan. Contoh hasil align photo seperti ditunjukkan di

bawah ini.

[ I
B A G e T s by

Apabila terdapat foto yang tidak ter-align dengan baik (terdapat tanda ‘NA’), proses align
dapat diulang hanya pada foto tersebut dengan melakukan pemilihan foto yang tidak ter-
align di panel workspace, kemudian klik kanan > pilih reset camera alignment,
kemudian dilanjutka n dengan Align Selected Cameras.

- ) @ Enable Cameras
f\..ﬂ @ ﬁ E‘L’ @ Q & Disable Cameras [ ]
‘i Workspace (1 chunk: Move Cisricean b
v | | Chunk 1(7T01 ca ]
= Remove C
¥ | Cameras (952 il
ASIOA gate Scale Bar
| DJI_0002..) - e
e d"-a" s
DJI_0004.. Reget Camera Alignment
DJI_00OS.. Hmate Image Quality...
DJI_000..
as
Invert Selection
DIO0T0.  ppasks >
=& DJI_0011.
A rt Depth... s
M oiowa  eotPe i
%] DI 0013 Che
.
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2.5. Inspeksi Kualitas Foto

Inspeksi kualitas foto dilakukan untuk membedakan foto yang tajam dan foto yang
blur/kabur. Foto yang kualitas gambarnya kabur akan menyebabkan penurunan kualitas hasil
pengolahan, oleh karena itu perlu dikeluarkan dari tahapan proses. Inspeksi kualitas foto dapat
dilaksanakan sebelum atau sesudah proses alignment. Apabila inspeksi dilakukan setelah proses
alignment, dan ada foto yang dikeluarkan karena indeks kualitasnya jelek, maka proses alignment
sebaiknya diulang untuk memperoleh hasil pemodelan yang lebih baik. Ukuran kualitas foto
ditentukan dari nilai indeks antara 0 dan 1. Semakin rendah nilainya, semakin jelek kualitas dan
ketajaman gambarnya. Sebagai panduan umum, batas antara nilai kualitas foto yang baik dan
kurang baik adalah 0,7. Pengeluaran jumlah foto juga harus mempertimbangkan ketersediaan
foto. Secara umum pengurangan sejumlah foto akan menyebabkan overlap/sidelap foto
berkurang, sehingga model yang dihasilkan menjadi tidak berkualitas.

Untuk melakukan inspeksi kualitas foto, langkah yang dilakukan sebagai berikut:

1. Dari Panel Photos, klik tombol tampilan Detail.

Phatos
oox ar RE®ES
Label Size Large Quality
S| DIOMTIPG  A000x3000 Medium 0.893895
| DN_DOTIJPG  4000X3000 Small 0.893337
&| DJI_0003JPG  4000%2250 0.892701
4l DJIDOORIPG 40003000 Detalls | 0891927
4| DJI_DODEIPG 40003000 0.890905
& DN_OO13JPG 4000%3000 0.890675
=& DNI_0002JPG 4000x3000 0.820162
4l O AT 10 AN 300N nasoaas |

2. Klik kanan salah satu atau beberapa foto, kemudian pilih Estimate Image Quality.

Open
Open in New Tab

& Enable Comeras
© Disable Cameras

Mave Cameras

7% Remove Cameras

Align Selected Cameras
Reset Camera Alignment
Estimate Image Quality..

Photos View Matches...

rHeex A, B - x _ L Filter Photos by Cameras l
Label Size Aligned Qui Invert Selection ke
A DIOMTIPG  4000x3000 085 Masks L |
= DILODN1IPG  A0D0x3000 DAL Export Depth. |

DI_O003IPG  ADDONZ250 085 |

0l o = o (Check Paths..
4 DJ1_OO0BJPG  40D0x3000 0as = e |
5 DILOOOGIPG 40003000 05 e |
4 DILO0I3IPG  4000x3000 08¢ ) Open Containing Folder |
=+ DN_O00ZIPG  40D0x3000 pac ™ Rename.. |
4| DI_O0DTIPG  40DDX3000 026 ) Show Info_ |
3 DNO0IZIPG  4000x3000 T p—r 11410318 ) |
< DILO003JPG  4000x2250 0883065 2MEI05063... DN

3. Pilih metode analisa yang diinginkan, apakah hanya beberapa foto tertentu (selected
photos), semua foto dalam chunk aktif (all photos) atau seluruh foto dalam project
(entire workspace). Agisoft akan mulai menghitung indeks kualitas setiap foto, dan
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2.6.

hasilnya disimpan di kolom Quality. Tekan menu kolom Quality untuk melakukan sorting
indeks kualitas foto dari yang terbaik hingga terburuk.

| [T
Phatos

X

M

H Analyze Photos

Farameters Label

¥ Applyto
(@) All cameras () Entire workspace
() selected comeras &

Date & time Make
2018:10:15053... DA
2081018 143... DN
20181015053 DN
20181018143, DA
201810118 143.. DA

2018108 143.. DA
201810:18143.. DA
20181016 050... DN
20180015053, DA
20181016 050... DA

208113053, DA
2081016050... DA
20183016 050.. DA
20181015053, DN
20181 054, DR
050.. DA
20181015053, Dn

Untuk mengeluarkan foto yang kualitasnya kurang bagus, klik foto yang akan dihapus,
kemudian klik tombol disable camera (tombol merah) atau remove camera (tombol
silang).

Apabila banyak foto yang indeks kualitasnya tidak bagus, maka survei dan perekaman
UAV harus diulang, karena apabila dilanjutkan, hasil model dan mosaic ortofoto yang
diperoleh tidak akan bagus dan akurat. Untuk memastikan agar terdapat jumlah foto
dengan indeks kualitas yang bagus, gunakan overlap dan sidelap yang tinggi (85 sampai
90 persen), sehingga apabila terdapat foto yang harus dihapus, sisa foto lain masih
memiliki overlap dan sidelap yang mencukupi untuk melanjutkan proses pengolahan.

Optimasi Alignment

Proses alignment foto akan menghasilkan model fotogrametri yang terdiri dari urutan

foto dan model permukaan tiga dimensi kasar yang disebut sparse point clouds (tie points).

Sparse point clouds ini menjadi dasar dalam menurunkan data yang lebih detil seperti dense

point clouds, mesh, dem dan ortofoto. Agar produk lanjutan tersebut mempunyai kualitas

dan akurasi yang baik, maka sparse point clouds ini perlu diolah terlebih dahulu, melalui

operasi optimasi alignment, dan operasi pemfilteran (gradual selection).

Optimasi alignment melalui operasi optimize cameras dilakukan untuk mengurai

kesalahan posisi (positional error) produk sparse point clouds. Optimasi dilakukan antara lain

pada panjang focus (fx, fy), koordinat principal points (cx, cy), sebagian distorsi radial (k1,k2,k3)

dan sebagian distorsi tangensial (p1, p2). Prosedur operasi optimasi yang harus dilakukan adalah

sebagai berikut:
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1. Dari Menu Workspace, Klik Kanan nama chunk, kemudian pilih process dilanjutkan

optimize cameras.

2. Centang pilihan f, cx, cy, k1, k2, k3, p1 dan p2.

timize Lamera ignment

B optimizeC Alig
General
M FAtf [JFitb1
M At ox, oy [JFtb2
M Ft ke M Atp1
Frtkz [ Fitp2
M Ftks O Fitp3
[JFtks [ Ftpse
Advanced
[] Adaptive camera model fiting

.

X

.
TI11hLL
Wipdopace (| chunks, 625 camern)
= T ek 1829 camers 977 331 bt 161
' et Achve
| Dupfeste

@ Eratils Chuess
@ Dsavie Churks
Save Churkes.
F P Chises
Ak
reems
Epent
e

Bl Dorses: Choud.
Bz Mesh.

. . o ow o=

Moo

et Pneraey Channad..

3. Untuk melihat informasi akurasi hasil alignment, dari menu Workspace, klik kanan nama

Chunk, kemudian klik Show Info. Informasi yang penting untuk diketahui adalah RMS

Projection Error dan MAX Projection Error. RMS Projection Error memberikan

informasi rata — rata pergeseran posisi obyek di dalam model, sementara Max Projection

Error memberikan informasi pergeseran terbesar yang ada di dalam model. Kondisi ideal

yang diharapkan adalah RMS dan MAX Projection Error kurang dari 1 pixel, makin kecil

nilainya, makin baik kualitas dan akurasi model tiga dimensi.

File Edit View Worflow Model Photo Onthe Tocls Help
Bel o Ql-B-e-A~F X G
‘Wiorkspace X M
BBk ooXx
% Workspace (1 chunks 629 camerss)
» Jm”mm]s?n_nu-.mml

[ Cameras (605/520 aligne @ Set Active

22 Tie Points (152,330 poin [l Duphicate...

@ Enabie Chunks

@ Disable Chanks
Save Chunks..,

% Remove Chunks

Add
Process
Expet

Impeort

Remove

Set Prienary Channel..
Set Brightness...

Set Raster Transferm...
Set Drawing Plane
Resit Drawng Plane
Reset Transform:
Rename..

Reference Settings...
Show Infa..

H chunk1 X
Property Value "
Cameras 629
Aligned cameras 606
Coordinate system WGS 84 (EP5G::4326)
Rotation angles Yaw, Pitch, Roll
Point Cloud
Points 152,330 of 238,379
RMS reprojection error 0.117458 (1.85157 px)
Max reprojection error 0.300364 (16.2803 pix)
Mean key point size 14,3531 pix
Point colors 3 bands, uintd
Key points Ne
Average tie point multiplicity 3.36904
v Alignment parameters
Accuracy Low
Generic preselection Yes
Reference preselection Yes
Key peint limit 40,000
Tie point limit 4,000
Filter points by mask Neo
Adantne camara modal fitting Var b
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2.7. Filtering Sparse Point Clouds

Apabila hasil RMS dan MAX Projection Error dari langkah sebelumnya menghasilkan nilai
kesalahan yang cukup besar, kita dapat melakukan optimasi ulang hasil alignment melalui
kombinasi operasi optimize cameras dan gradual selection, untuk memperkecil nilai
reprojection error. Dalam gradual selection, terdapat beberapa tahapan yang diuraikan pada
gambar di bawah ini.

Gradual Selection Workflow

Reconstruction Projection Tighten Tie Point  Control Points  Reprojection
Uncertainty Accuracy Accuracy Value Input Error

: : : : I
U JU

Optimize Optimize Optimize Final Optimize
Cameras Cameras Cameras Cameras
F, &, oy, k1, k2, K3, F. &, o, ki, K2, k3, F, ox, oy, k1, k2, K3, F, o oy, K1, k2, k3,
p1, P2 p1. p2 k4, p1, p2, p3, p4 k4.p1, p2, 3, p4

Agisoft Photoscan Workflow by USGS

2.7.1 Reconstruction Uncertainty

Reconstruction uncertainty adalah tahap pertama dari perbaikan kualitas hasil alignment
foto. Pada tahap ini kesalahan geometri dari model sparse point clouds diperbaiki dengan cara
menyeleksi titik — titik ketinggian yang dianggap memiliki kesalahan geometri yang besar.
Prosedur yang dilakukan sebagai berikut:

1. Dari Menu Model, pilih Gradual Selection, kemudian pilih Reconstruction

Uncertainty.
B teshgisoft psx™ — Agisoft PhotoScan Professional E Gradual Selection X
File Edit View Workflow Model Photo Ortho Tools Hel
E 5 o Navigation K < - .
Workspace .1 Rectangle Selection E = Criterion: |Reconstruction uncertainty v
i 1 () Circle Selection |
sWMR DGO X W Crdesdacion L Level: 10,0406 |
Workspace (1 chunks, 620 ca 2 Free-Form Selection .
~ [ Chunk 1(629 cameras, 1 Gradual Selection... '

Cameras (606/629 alic _
88 Tie Points (152330 pc *  Draw Point
A, Draw Polyline 10.0 0.0

Draw Polygon

[oc ] coel |

Transform Object *

Transform Region »
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2.7.2

Geser slider level sampai ke angka 10, jika lebih dari 50% point clouds terpilih, naikkan
ke level yang lebih tinggi (maksimal level 50). Selanjutnya hapus point clouds yang
terpilih dengan menekan tombol delete di Keyboard.

Selanjutnya lakukan optimize Camera dengan pilihan yang dicentang adalah parameter
f, cx, ¢y, k1, k2, k3, p1, dan p2.

Lakukan pengulangan langkah 1 sampai 3 setidaknya dua kali, usahakan pada
pengulangan ke-2 sampai pada Level 10, tanpa menghapus banyak points.

Show Info

Cek penurunan nilai Reprojection Error menggunakan tombol

sebagaimana telah dijelaskan pada sub-bab sebelumnya.

Projection Accuracy

Projection Accuracy adalah tahap kedua dari perbaikan kualitas hasil alignment foto. Pada

tahap ini kesalahan model sparse point clouds akibat kegagalan pixel matching diperbaiki.

Prosedur yang dilakukan sebagai berikut:

1. Dari Menu Model, pilih Gradual Selection, kemudian pilih Projection Accuracy.
H teshgisoft psx™ — Agisoft PhotoScan Professional B Gradual Selection x
File Edit View Workflow Model Photo Orthe Tools Hel
5 Navigation = - —
S “1 Rectangle Selaction E" Criterion: | Projection accuracy "
cBER L 99X L) Circle Selection Levet: '499993 I

~ | Chunk 1(629 cameras, 1
Cameras (606/629 alic

Workspace (1 chunks, 620 ca »2

82 Tie Points (152330 pe ©

Free-Form Selection
Gradual Selection...

Draw Point

0.0

A, Draw Polyline 50.0
Draw Palygon

Ruler | OK I L Cancel |

Transform Object »

Transform Region ¥

Geser slider level sampai ke angka 3, jika lebih dari 50% point clouds terpilih, naikkan
ke level yang lebih tinggi (maksimal level 50). Selanjutnya hapus point clouds yang
terpilih dengan menekan tombol delete di Keyboard.

Selanjutnya lakukan optimize Camera dengan pilihan yang dicentang adalah parameter
f, cx, ¢y, k1, k2, k3, p1, dan p2.

Lakukan pengulangan langkah 1 sampai 3 setidaknya dua kali, usahakan pada
pengulangan ke-2 sampai pada Level 3, tanpa menghapus banyak points.

Show Info

Cek penurunan nilai Reprojection Error menggunakan tombol

sebagaimana telah dijelaskan pada sub-bab sebelumnya.

25



2.7.3 Penajaman Nilai Akurasi Titik Ikat

Penajaman nilai akurasi titik ikat dilakukan agar sparse point clouds yang tersisa memang
memiliki nilai akurasi yang tinggi, sehingga titik dengan akurasi lebih rendah akan dihilangkan
dari model. Prosedur yang dilakukan sebagai berikut:

1. Dari Panel Workspace, geser ke Reference, kemudian pilih Settings. Selanjutnya

ubah nilai akurasi titik ikat dari 1 ke 0.1.

EEET,0EEH ® —

=
Lengtude un-rg Alttude (m ~ E Reference Settings
L 106111822 -B1T3067 242835000 bt i
_0OC... 106111805 -B.ATa227 242 835000
L 106111806 -6.074434 242535000 WGS B4 [EPSG114328) * [0
Ia? 111808 -E\l.'J.ITdE 242035000 [ Camra reference
- 108111807 -6.1T4852 242.935000
L= 106171808 6175261 242,535000 WS B4 [EPSG: 4106
~ 106171808 6173464 242,835000 O ST
000, 108.111807 -BATSTTS 242.835000
- 106111808 -6.173980 242,935000 VIS B4 (EPSG:4308)
.- 106.111808 -6.176289 242.835000 i T =
I 108111808 6176485 243035000 anihick v e
L. 106.711809 -6,176804 243,035000
L Measurement A Tmage Coordnstes Acr
001, 106111808 £ITI012 243035000 = s s b
1, 106111808 5177321 242935000 ¥ Camera acouracy (m): 10 Marker accuracy (pix):  [D.1
5 B |
Camera acuracy (deg): |2 Tie poirit acruracy (oe: E[
Longitude Latitude Alttude (m] : —_—
Marker scouracy {m): |0.005
Control points Seale bar seeuracy () [0.001
ot ok fooor ]
Miscellaneaus
Ground albtude (m): [ ]
Coc ] ool | |
1% »
| Scale Bars Distance {rm) Accutscy ) Erroie {m)
| Tatal Error
Control scale ...
Check scale b,
Phatos
J
-
o
Workspgee  Refarence Fhotos

2. Selanjutnya lakukan optimize Camera dengan pilihan yang dicentang adalah parameter
f, cx, ¢y, k1, k2, k3, k4, b1, b2, p1, p2, p3 dan p4.

3. Cek penurunan nilai Reprojection Error menggunakan tombol Show Info
sebagaimana telah dijelaskan pada sub-bab sebelumnya.

2.7.4 Input Ground Control Points/Markers dan Scale Bars

Input ground control points (GCP) tidak dibahas dalam modul ini.
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2.7.5 Reprojection Error

Reprojection Error adalah tahap keempat dari perbaikan kualitas hasil alignment foto.
Pada tahap ini kesalahan pergeseran posisi titik pada foto dengan titik yang sama di model sparse
point clouds diperbaiki dengan cara menghilangkan titik — titik ketinggian yang memiliki nilai
pergeseran posisi yang besar. Prosedur yang dilakukan sebagai berikut:
1. Dari Menu Model, pilih Gradual Selection, kemudian pilih Reprojection Error.

B teshgisoft psx™ — Agisoft PhotoScan Professional
File Edit View Workflow Model Photo Orthe Tools Hel E Gradual Selection X
5 R Navigation =
Workspace _} Rectangle Selection E = ) I R ‘
- » v
LR L 90X [ Grdesedecton Criterion: | Reprojection error
Workspace (1 chunks, 620 ca ~2 Free-Form Selection Level: 0.300364 I
v Chunk 1({629 cameras, 1 Gradual Selection...
Cameras (606/629 ali¢ '
82 Tie Points (152330 pc ©  Draw Point
A, Draw Polyline
_/ Draw Polygon 0.3 0.0
Ruler 1
| oK | L Cancel
Transform Object L
Transform Region b —

2. Geser slider level sampai ke angka 0.3, jika lebih dari 10% point clouds terpilih, naikkan
ke level yang lebih tinggi. Selanjutnya hapus point clouds yang terpilih dengan menekan
tombol delete di Keyboard.

3. Selanjutnya lakukan optimize Camera dengan pilihan yang dicentang adalah parameter
f, cx, ¢y, k1, k2, k3, k4, b1, b2, p1, p2, p3 dan p4.

4. Lakukan pengulangan langkah 1 sampai 3 setidaknya dua kali, usahakan pada
pengulangan ke-2 sampai pada Level 0.3, tanpa menghapus banyak points.

5. Cek penurunan nilai Reprojection Error menggunakan tombol Show Info
sebagaimana telah dijelaskan pada sub-bab sebelumnya.

2.7.6 Image Count

Image count adalah teknik pemilahan point clouds berdasarkan berapa jumlah foto yang
digunakan untuk menghasilkan setiap titik ketinggian. Pada umumnya, point clouds yang
dianggap berkualitas adalah point clouds yang diperoleh dari setidaknya tiga foto yang
bertampalan. Sementara point clouds yang hanya berasal dari dua foto seringkali memiliki
kesalahan posisi yang besar, oleh karena itu bisa dihilangkan dengan operasi Image Count.
Meskipun demikian, penggunaan Image Count harus berhati — hati, karena dalam kenyataannya,
seringkali point clouds banyak diperoleh dari hanya dua foto (terutama untuk survei dengan
konfigurasi sidelap/overlap kurang dari 80%), sehingga menghapusnya dapat menyebabkan
jumlah point clouds yang berkurang drastis, dan pada akhirnya mengurangi kualitas output
selanjutnya. Prosedur yang dilakukan untuk filter Image Count sebagai berikut:
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1. Dari Menu Model, pilih Gradual Selection, kemudian pilih Image Count.
[ testgisoft psx® — Agisoft PhotoScan Professional | = = ]
File Edit View Workflow Model Photo Ortho Tool Hel | B Gradual Selection X |
=] H i MNavigation kL
Warkspace L _} Rectangle Selection F » Criterion: IJTlﬂge count v ‘
1 B [ L} Cirde Selection -
oM b @ >< = Level: 2 |
Workspace (1 chunks, 620 ca ~ Free-Form Selection
v Chunk 1 (629 cameras, 1 Gradual Selection... '
Cameras (606/629 alic | :
83 Tie Points (152,330 pe ' Draw Point 2 20
A, Draw Polyline
_/ Draw Polygon I 0K | ‘ Cancel
Ruler
Transform Object *
Transform Region ’

2.

2.8.

Geser slider level sampai ke angka 2. Harap berhati — hati, apabila jumlah point clouds
terpilih lebih dari 40%, sebaiknya teknik ini tidak digunakan. Untuk menghapus point
clouds terpilih dapat dilakukan dengan menekan tombol delete di Keyboard.

Selanjutnya lakukan optimize Camera dengan pilihan yang dicentang adalah parameter
f, cx, ¢y, k1, k2, k3, k4, b1, b2, p1, p2, p3 dan p4.

Cek penurunan nilai Reprojection Error menggunakan tombol Show Info
sebagaimana telah dijelaskan pada sub-bab sebelumnya.

Pembangunan Dense Point Clouds

Dense Point Clouds adalah kumpulan titik tinggi dalam jumlah ribuan hingga jutaan titik

yang dihasilkan dari pemrosesan fotogrametri foto udara atau LIDAR. Dense point clouds

nantinya dapat diolah secara lebih lanjut untuk menghasilkan Digital Surface Model, Digital

Terrain

lainnya.

1.

Model, bahan masukan dalam proses pembuatan orthofoto dan kepentingan pemetaan

Untuk membuat Dense Point Clouds, setelah proses alignment selesai dari menu
Workflow klik Build Dense Point Clouds. Kemudian muncul pilihan Quality dan Depth
Filtering. Untuk Quality terdapat beberapa pilihan mulai dari Lowest hingga Ultra High.
Makin tinggi kualitasnya, makin lama waktu pemrosesan dan makin besar alokasi memory
RAM yang dibutuhkan. Adapun untuk parameter depth filtering menunjukkan cara
perlakuan ter-hadap titik tinggi yang disinyalir merupakan noise (outliers). Ciri-cirinya
biasanya nilai ketinggiannya jauh lebih besar atau jauh lebih kecil dari titik - titik di
sekitarnya. Mild filtering ditujukan untuk rekonstruksi model 3D yang kompleks dan
mempunyai banyak detil, sedangkan Aggressive filtering ditujukan untuk rekonstruksi
model 3D yang sederhana dan tidak mempunyai banyak detil. Klik OK.
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2.9. Pembangunan Model 3D (Mesh)

Model 3D atau mesh adalah salah satu keluaran utama dari pemrosesan foto udara di
Agisoft. Model 3D nanti digunakan sebagai dasar pembuatan DEM baik DSM maupun DTM dan
juga orthofoto. Mesh yang dihasilkan juga dapat dieksport ke format lain untuk diproses lanjutan
di software lain seperti Google Sketchup, AutoCAD atau ArcGIS.

1. Untuk membuat Mesh, dari Menu Workflow klik Build Mesh. Muncul pilihan Mesh
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Parameter. Untuk Surface Type, ada dua pilihan, Height Field dan Arbitrary. Arbitrary
digunakan untuk model 3D umum seperti bangunan, patung dan lain — lain sedangkan
Height Field digunakan untuk obyek permukaan bumi seperti Medan/Terrain, dan struktur
spasial seperti jaringan Pipa, kabel, dan lain-lain. Gunakan Height Field untuk
memprosesan orthofoto.

Untuk Source Data dapat menggunakan Sparse Point Cloud atau Dense Point Cloud dari
tahap pemrosesan sebelumnya. Untuk memperoleh hasil terbaik, gunakan Dense Point
Clouds. Untuk parameter Face Count, ada pilihan dari Low, Medium hingga High. Face
Count ini menentukan jumlah polygon mesh yang akan dihasilkan. Face count High dapat
menghasilkan mesh dengan jutaan polygon yang mungkin nanti akan menimbulkan
permasalahan visualisasi, oleh karena itu harus ditentukan dengan bijak. Selain tiga
pilihan diatas, juga terdapat dua pilihan tambahan yaitu Interpolation dan Point Classes.
Untuk interpolation sendiri ada dua pilihan, yaitu interpolated dan extrapolated.
Interpolated mode akan memungkinkan beberapa gap diantara foto yang tidak terproses
akan diinterpolasi secara otomatis. Pilihan extrapolated tidak digunakan dalam
pemrosesan orthofoto. Klik OK.
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2.10. Pembuatan Texture

Model texture adalah model fisik 3D dari kenampakan - kenampakan yang ada di area
liputan foto. Model texture dapat dieksport ke dalam berbagai format model 3D yang nantinya
dapat dimanfaatkan untuk membuat model 3D via desktop software lain atau via website.

1. Untuk membuat model texture, dari Menu Workflow klik Build Texture. Muncul pilihan
Texture Parameter, ada bebera-pa pilihan mapping mode, mulai dari Generic, Adaptive
Orthophoto, Orthophoto, Spherical, Single Photo, Keep uv. Anda dapat memilih dan
membandingkan beberapa mapping mode yang tersedia untuk memperoleh hasil terbaik.
Demikian pula untuk parameter texture size/count dapat digunakan untuk mendetilkan
tekstur dengan konsekuensi file tekstur yang semakin besar ukurannya. Untuk pilihan
blending mode, ada tiga pilihan, Mosaic, Average, Max In-tensity dan Min Intensity.

a. Mosaic akan mempertimbangkan detail dalam setiap foto sehingga menghasilkan
orthofoto yang balance dari segi warna dan kedetilan.

b. Pilihan average akan menggunakan nilai piksel rata-rata dari setiap foto yang overlap.

c. Adapun untuk max dan min intensity menggunakan intensitas maksimum dan
minimum dari piksel yang bertampalan/overlap.

Anda juga dapat mencentang pilihan Enable Color Correction untuk melakukan koreksi
warna di setiap foto, namun waktu pemrosesan akan menjadi lebih lama.
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2.11.

Pembuatan DEM

DEM atau Digital Elevation Model adalah model medan digital dalam format raster/grid
yang biasanya digunakan dalam analisa spasial/GIS berbasis raster. Dari data DEM biasanya
dapat diturunkan informasi elevasi, lereng, aspek, arah penyinaran, hingga ke pemodelan lebih
lanjut seperti cut and fill, visibility, pembuatan DAS dan lain-lain. Terdapat dua terminology terkait
DEM, vyaitu DSM (Digital Surface Model/ketinggian dihitung dari permukaan penutup lahan,
seperti atap bangunan, atap pohon, jembatan, dll) dan DTM (Digital Terrain Model/ketinggian
dihitung dari permukaan tanah). Untuk modul ini, terminology yang digunakan adalah DSM.

1. Untuk membuat DEM, dari Menu Workflow klik Build DEM. Muncul pilihan DEM
Parameter. Untuk Coordinate System, anda dapat mengatur apakah DEM akan dieksport
dalam sistem koordinat geografis atau projected. Untuk Source Data dapat menggunakan
Sparse Point Cloud atau Dense Point Cloud dari tahap pemrosesan sebelumnya. Untuk
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memperoleh hasil terbaik, gunakan Dense Point Clouds. Untuk interpolation sendiri ada

dua pilihan, yaitu interpolated dan extrapolated. Interpolated mode akan memungkinkan

beberapa gap diantara foto yang tidak terproses akan di-interpolasi secara otomatis

sehingga menghasilkan DEM yang solid dan tidak mempunyai Gaps. Pilihan extrapolated

tidak digunakan dalam pemrosesan DEM. Parameter Region menentukan luas wilayah

yang akan dieksport, anda dapat membiarkan seperti default atau mengaturnya secara

manual. Klik OK.
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2.12. Pemisahan DTM dan DSM

Pembuatan DEM yang diuraikan pada sub bab 2.11 diatas sebenarnya adalah metode
pembuatan DEM dengan jenis DSM atau Digital Surface Model. DEM sendiri secara umum dapat
dipisahkan menjadi dua jenis data, yaitu DSM (Digital Surface Model) dan DTM (Digital Terrain
Model). DSM menghitung tinggi/elevasi sampai ke permukaan tanah beserta obyek di atas tanah
tersebut. Misalnya, di suatu bidang tanah terdapat sebuah rumah, maka nilai ketinggian dalam data
DSM dihitung dari ketinggian permukaan tanah ditambah ketinggian rumah tersebut. Sedangkan untuk
data DTM, ketinggian hanya dihitung sampai ke permukaan tanah, lepas dari apa ada obyek
(permukiman, gedung, pohon) di atas tanah tersebut atau tidak. Gambaran ilustrasi perbedaan DSM
dan DTM dapat dilihat pada gambar di bawah ini.

@ Digital Surface Model
Digital Terrain Model
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Langkah — langkah yang dilakukan untuk membuat DTM dari data Dense Point Clouds sebagai
berikut:
1. Dari Menu Tools, pilih menu Dense Cloud, kemudian pilih Classify Ground Points.
Selanjutnya, muncul tampilan parameter klasifikasi, biarkan saja sesuai default, klik OK.
Proses klasifikasi ground points akan berjalan.

B Ciassify Ground Points X
Ortha  Toole  Help
. Markers 4 4 > I E S
Tie Faints + [ Classes
Dense Cloud X Colorize Dense Cloud., From: Any class v
Meah : lewmert Pt Mermals, —
" Orthamasaic J Classity Ground Points.. Ta: Cround + Low Pointe ~
Lens ' Asian Class: CirlShiftal
i Camnera Calibration.. Rasat Classification Parameters
PR Optimize Cameras.. Select Points by Masks.. |
i 2 M ) 5 2
UMQUE" Caibrate Reflactarice. Sefect Points by Color.. angle (%) iss | 1
Calibrate Colors.. Select Points by Shape Max distance {m): |l
foani Ellinc At —
Cell size (m): [s0
Concel

2. Setelah selesai, klik tampilan Dense Point Clouds Class.

E test.psx* — Agisoft PhotoScan Professional

File Edit View Workflow Model Photo Qrtho Tools Help
H Rl lvM-F-ArS K H A g $ 2] oA R

Workspace & x  Model - loud Classes

3. Tampilan di agisoft akan memperlihatkan Dense Point Clouds yang terklasifikasi menjadi
dua warna, putih dan coklat. Putih merupakan obyek bukan tanah, dan coklat merupakan

obyek tanah.

P X Moce

4. Untuk membuat DTM, lakukan prosedur Build DEM sebagaimana diuraikan di Sub bab
2.11. Pada saat jendela Build DEM muncul, di Menu Point Classes pilih tombol Select,
kemudian centang pada kelas Ground saja, Klik OK.
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Hasil akhir berupa DEM dengan jenis DTM (hanya informasi ketinggian medan). Berikut
ini perbandingannya dengan DSM untuk melihat perbedaan antara kedua data.

DSM
2 ml
73Fm
456 m
86.1m
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DTM

lﬂOml

729m

456 m

2.13. Ekstraksi Garis Kontur Ketinggian

Kontur ketinggian (elevasi) dapat diturunkan baik dari data DSM maupun data DTM yang
dihasilkan dari prosedur pembuatan DEM pada sub bab 2.12. Data kontur yang diperoleh dapat
dieksport ke format CAD (DXF) maupun GIS (SHP) untuk kemudian diolah lebih lanjut di
perangkat lunak CAD atau GIS. Prosedur pembuatan garis kontur ketinggian sebagai berikut:

1. Dari Menu Tools, pilih Generate Contours. Muncul jendela parameter kontur, untuk
source data sudah otomatis terisi (tergantung pada DEM yang dibuat, DSM atau DTM).
Kemudian isikan ketinggian minimal dan maksimal dari data kontur yang akan dibuat
(atau biarkan sesuai default), dan kemudian isikan interval garis kontur yang diinginkan.

Klik OK.
=
bto Orho Tools Help
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Tie Points
Dense Cloud L
] Mk » —
Ints) [R] S . B Generate Contours X
Lens L
I8 Camera Calibration.. Parameters
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[Medlum QU< Cajibrate Reflectance.. Source data: DEM

Calibrate Colors..

Min altitude (m): [45.6384 |
Set Primary Channel... e —

4 SetBrightness.. Max altitude (m): |.ll}D.121 |

L - ] Set Raster Transform. Interval {ITI}: ’1'—‘
Generate Contows... — :
Survey Statistics.. [] Prevent intersections

«» Run Seript.. Ctri+R

R e = ][ o=

37



2. Contoh hasil data kontur disajikan pada gambar di bawah ini.

3. Untuk mengekspor hasil data kontur ke format DXF, KML atau SHP, dari menu Workspace,
expand Tab Shape, kemudian klik kanan di data kontur, pilih Export Data, kemudian
tentukan lokasi penyimpanan dan jenis format yang diinginkan.

. 4 TRV ¥ T W O ST T TS

Warkspace 8% model oo O 2 H savers

2.14. Pembuatan Orthofoto

Orthofoto adalah Foto udara yang telah dikoreksi kesalahan geometriknya menggunakan data
DEM dan data GCP sehingga dapat dimanfaatkan untuk kepentingan pemetaan tanpa adanya
inkonsistensi skala di sepanjang liputan foto. Orthofoto dapat dibuat setelah tahap pembuatan Dense
Point Clouds, Mesh dan DEM selesai dilakukan,

1. Untuk membuat orthofoto, dari Menu Waorkflow Klik Build Orthomosaic. Muncul pilihan
Orthomosaic Paremeter. Untuk pilihan Projection, pilih antara koordinat geographic atau
planar/projected. Untuk parameter Surface, pilih DEM vang dihasilkan dari langkah
sebelumnya. Untuk pilihan blending mode, ada tiga pilihan, Mosaic, Average, Max Intensity
dan Min Intensity. Mosaic akan mempertimbangkan detail dalam setiap foto sehingga
menghasilkan orthofoto yang balance dari segi warna dan kedetilan. Pilihan average akan
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menggunakan nilai piksel rata-rata dari setiap foto yang overlap. Adapun untuk max dan min
intensity menggunakan intensitas maksimum dan minimum dari piksel yang ber-
tampalan/overlap. Anda juga dapat mencentang pilihan Enable Color Correction untuk
melakukan koreksi warna di setiap foto, namun waktu pemrosesan akan menjadi lebih lama.

CIAWI,psx* — Agisoft PhotoScan B Build 0romosaic R
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2.15. Batch Processing

Batch processing adalah otomatisasi rangkaian proses pengolahan foto udara UAV seperti
yang telah dijelaskan pada bahasan sebelumnya (align photos > Optimize Align > build Dense Cloud
> Build Mesh > Build DEM > Build Orthomosaic). Pada batch processing ini, setiap rangkaian
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pengolahan yang sudah selesai secara otomatis dilanjutkan oleh rangkaian proses pengolahan
berikutnya, sampai selesai. Operator tidak mengintervensi proses pengolahan, tetapi dapat mengatur
preferensi yang diperlukan di setiap tahap pengolahan menggunakan tombol edit. Untuk
menambahkan proses pengolahan baru, gunakan tombol Add. Selain itu, perlu dicentang pilihan Save
Project Each Step agar proses tidak berhenti ditengah jalan, karena pada tahap tertentu, software
akan meminta project untuk di-save, oleh karena itu lebih aman untuk mengatur lokasi penyimpanan

project sebelum batch processing dilakukan.

-
=

| Order Job Type Applies To
1 AlignPhotos Al Chunks | H editsob %
IZ Optimize Align... All Chunks
3 Build Dense Clo... All Chunks Job type: |Buld Orthomasaic -
|14 Build Mesh . Churks v
!s Build DEM All Chunks Aoty b ,
|6 Build Othomos... All Chunks |
[T
| 1 | i | [
|| N Settings: ]
Property Value 2
Resolution (m) 0
Surface Mesh
Blending mode Mosaic b
Holefilling
— Add === . m Li | Enable back-face culling S;TEEZ
rojection
£ save project after each step | ¥ Use custom region Mo v
oK Cancel
L
Tombol Keterangan
Add Untuk menambahkan proses pengolahan (job)
Edit Untuk mengatur pilihan dari proses pengolahan
Remove Untuk menghapus proses pengolahan (Job)

Save ( Gambar Disket) | Untuk menyimpan rangkaian batch processing dalam bentuk file

Load ( Gambar Folder)  Untuk membukan rangkaian batch processing yang telah disimpan
dalam bentuk file.

Tombol UP " Untuk menggeser proses pengolahan ke atas

Tombol DOWN " Untuk menggeser proses pengolahan ke bawah

40



TUTORIAL 3

Pengolahan dan Tampilan Data

3.1. Digitasi On Screen

Digitasi on screen merupakan salah satu teknik input data yang lazim digunakan dalam
SIG. Disini peta atau citra satelit yang menjadi sumber data/referensi ditampilkan di layar monitor,
kemudian operator melakukan proses interpretasi dan deliniasi menggunakan alat yang
disediakan perangkat lunak.

3.1.1. Digitasi Objek Titik

Proses digitasi on screen dilakukan diatas citra satelit atau peta dasar lainnya untuk
membentuk suatu layer baru, digitasi dilakukan dengan langkah — langkah sebagai berikut:
1. Menambahkan layer baru pada ArcMap
Buka citra satelit resolusi tinggi hasil pemotretan UAV dan peta administrasi
menggunakan /con Add Data pada toolbar atau dari menu File > Add Data

2. Membuat layer baru objek titik (point)
Buka ArcCatalog pada Arcmap yang terletak pada sisi kanan jendela ArcMap, pilih lokasi
folder tempat penyimpanan file berupa shapefile (shp). Klik kanan pada folder >
New - Shapefile
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[ Create Newsst =
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3. Digitasi on-screen dapat dilakukan dengan mengaktifkan tombol Toolbar Editor,

Editor - Start Editing. Memulai digitasi dengan memilih menu Create Feature yang

terletak pada sisi kanan jendela ArcMap atau Menu Editor. Pilih layer yang akan diedit

(bendungan).
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4. Digitasi On-Screen dengan objek titik dapat dilakukan secara langsung berdasarkan lokasi
kenampakan bendungan yang terlihat pada citra/foto udara atau berdasarkan data
koordinat titik X dan Y yang telah diketahui.

Klik Kanan pada Muka Peta - Absolute X, Y - Isi Kolom Longitude dan Latitude

Snap To Feature »

e

Absolute X, Y [ x |
Absohste X ¥ Long:l X 06,849)
-_'rs.atr 3 point nr.,er(e.u using an Lat: _6,654
EEACE Iy MESsUrement, Y

Digitasi On-Screen dengan objek titik juga dapat dilakukan secara langsung, sebagai hasil
interpretasi pada citra/foto udara.

5. Klik Save Edit atau Stop Editing untuk keluar dari mode editing mengakhiri digitasi
dan menyimpan hasil editing/digitasi

T o ’ : Q Unsitied - ArcMap - o 5

1 [ -|m | File Edit View Bockmeks luset Selection Geoprocessing Customze Windaws  Hel
—grr | L |Dz=e Bx 0ok a0
| BEAPQ il ++ H-T(xlo® Bg Ester | - R Snappings &
| ; =49 BB aw - A P
S, i il Ao Reis s L 5
4 |EdA B o

......

3.1.2. Digitasi Objek Garis

Proses digitasi on screen dilakukan diatas citra satelit atau peta dasar lainnya untuk
membentuk suatu layer baru, digitasi dilakukan dengan langkah — langkah sebagai berikut:

1. Ulangi langkah 1 dan 2 berdasarkan Subbab 3.1.1, kecuali pada Type Feature: Polyline.
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Pilih Feature Type berupa Polyline (garis) - Isi kolom Name sebagai nama layer >
Edit > Atur sistem koordinat: Geographic Coordinate System > WGS 1984 >

Create New Shapefile 3¢ |Spatial Referance Properties
= XY Coordinate System
. [
MName: |[alan |
l" ! C b P
-E!r | Type here to sezd
Feature Type: Polyline
o s i &) ITRF 2000
Spati erence & 1TRF 2005
; L
S ) 1TRF 2008
m
Descripti O rewc az2
o &) WGs 1986
| Geographic Coondinate System: € wos 1972

Name: GCS_WGS5_1384

[] Show Detais

[ Coordinates will cortain M vahses. Used to store route data
[ Coordinates will contain Z values. Used to store 3D data

oK

Cancel

Current coordnate system:

GC5_WGS_1584
WID: 4326 Authority: EPSG

Anguiar Unit: Degres (0,0 174532925199433)
Prime Meridian: Greemwich {0,0)
Datum: D_WG5_1984
Spheroid: WGS_1984
Semimajor Axis: 6378137,0
Semimnor Axis: 6356752, 319245179
Inverse Flattening: 238,257223563

18 8

|

&2

|

2. Digitasi On-screen dapat dilakukan dengan mengaktifkan tombol Toolbar Editor :
Editor - Start Editing - Pilih layer objek garis yang akan diedit yaitu layer jalan .
Memulai digitasi dengan memilih menu Create Feature yang terletak pada sisi kanan

jendela ArcMap atau Menu Editor. Pilih layer yang akan diedit (jalan).

Editorr »

Start Editing

/]

[ Start Editing

edit features or attributes

| & Press F1 for more help.

Start an edit session so you can

Snapping ¥
More Editing Tools  »
Editing Windows »

Cptions...

.r"/.'

Nl:th 22BN

Eq

%

O-A-

g Bl b e g

#
%

.

s i covne

3. Digitasi On-Screen dengan objek garis dapat dilakukan secara langsung interpretasi pada

citra/foto udara



4. Klik Save Edit atau Stop Editing untuk keluar dari mode editing mengakhiri digitasi

3.1.3.

membentuk suatu layer baru, digitasi dilakukan dengan langkah — langkah sebagai berikut:

1.

dan menyimpan hasil editing/digitasi.

Editer=] b ", | W B g P 2 ERA File Edit View Bookmads dnsert Selection
o | Nsws im0 o®-fre
T NG = ARANQ nlies B v O
| S aar =
tap Editing | Table OF Comtents LE 3
Stop the ed# session. If you have _|3 S8 4
any unsaved edits, you are 7
prompted to save them, 5 [ Caave_Ris Minumn
5 B Ciassd_lalers
Bl
L
& uifen, MFet Band |
- 1 Geven: Bond
J W Bl Baed
Snapping v I
More Feiting Tooks  + | i '-\_
Edting Windows  + | ) T,
Opticas... | i

Digitasi Objek Luasan

SRy Deng R

Geoprocesyng  Costomoe  Wendows  Help

FmEeEm i,

By e [5] 5
H-A-

PSS

108 152 -8 85T Decimal Degiesi

saimiea j aieain 1 vy [

Proses digitasi on screen dilakukan diatas citra satelit atau peta dasar lainnya untuk

Ulangi langkah 1 sampai 3 berdasarkan Subbab 3.1.1, kecuali pada Type Feature:

Polygon.

Pilih Feature Type berupa Polygon (luasan) - Isi kolom Name sebagai nama layer
- Edit > Atur sistem koordinat: Geographic Coordinate System > WGS 1984

-> 0K

Create New Shapefile

X | ipatial Reference Properties

XY Coordinate System

Name: GC5_WGS_1384

Name: daerah_ingasi
T~ e {55
Feature Type: Palygon & =" S e —
8 TTRF 2000
tinl Refarsncs ITRF 2005
S &) ITRF 2008
Descnption: € NswC sz:2
iif = £} WGs 1966
Geographic Coordinate System @ wes 1872

+ 1 Profly

Cufeik coaylinght Wysia;

Cledl G-n

aatl Systenns

GCS_WGS_1534
WID: 4326 Authority: EPSG

Datum: [)_WGS_1984
Spheroid; WES_1984

[ 5hew Details

Semmepr Axs: 6378137,0

[] Coordinates wil cortain M values. Used to store mute data.
[ Coordnates wil contain Z values. Used to store 30 data.

OK Cancel

Anguler Linit: Degree (0,017451292519943)
Frime Meridan: Graenwich (0,0)

Sesmaminor Axi: 6356752, 314245179
Inwerse Flatbening: 258,257221563
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2. Digitasi On-screen dapat dilakukan dengan mengaktifkan tombol Toolbar Editor, Editor
- Start Editing. Pilih layer objek garis yang akan diedit yaitu layer daerah irigasi.
Memulai digitasi dengan memilih menu Create Feature yang terletak pada sisi kanan
jendela ArcMap atau Menu Editor. Pilih layer yang akan diedit (daerah irigasi).

Editor~ | »

st dting

= ‘,-" -

: Start Editing

| Start an edit session 5o you can
| edit features or attributes.
f

| % Press F1 for more help.

Snapping 3
More Editing Tools  »
Editing Windows »

Options...

Eq =

b4

P P s A B EE 7Y

I Q untitied - Aschap - o x|

file Ednt Wiew Bookmads Imet Selection Oecprocessing Customize Windows  Hep
Deds B x| 0 g~ (1400 ] SEEEO
RO EmMASS TR e[k 5 e

HE PO I e -
- - A-

= 1y

| Table OF Cantents
E808d

& Layens
% [ i At Mingm
% @ Cisailalan

i B
2 Cawsl
Rl
M Re=d Band 1
[ Green: Band 2
[

1068 -655

3. Digitasi On-Screen dengan objek garis dapat dilakukan secara langsung berdasarkan

interpretasi pada citra/foto udara.
4. Klik Tombol Save Edit atau Stop Editing untuk keluar dari mode ediiting mengakhiri

digitasi dan menyimpan hasil editing/digitasi.
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3.2. Simbolisasi

Salah satu fungsi dan kemampuan SIG adalah kemampuan melakukan pemetaan dan
pembuatan peta. Salah satu aspek dalam pembuatan peta adalah desain peta dan simbolisasi
data. ArcGIS mempunyai tool dan fasilitas untuk memvisualisasikan data spasial dalam berbagai
cara, sesuai dengan informasi yang ingin ditampilkan. Simbolisasi peta sendiri dapat didefnisikan
sebagai penerapan sebuah symbol tertentu (bisa berupa warna, pola, bentuk, ukuran, sudut,
transparansi) terhadap sebuah kenampakan spasial, sehingga bisa diidentfkasi dalam sebuah
peta

3.2.1. Simbolisasi Titik

Sebelum melakukan simbolisasi, layer data yang akan disimbolisasi harus dimasukkan
dulu ke dalam ArcMap Document yang akan diedit. Simbolisasi dilakukan dengan langkah-langkah
sebagai berikut:

1. Buka layer Ciawi_Air_Minum.shp
2. Klik kanan pada layer yang akan dilakukan simbolisasi, pilih Properties

Table Of Contents x|
a8 |
o = layers |

. @ Copy

5 [ JawaBarat_lalanNasic ¥ Remove

[ JAWABARAT Jalan

N Open Attribute Table
Joins and Relates b

= [0 JawaBarat_SawahBak (> Zoom To Layer

B ClAWLLT

RGB Visible Scale Range »
Ml Reck  Band_1 Use Symbol Levels
B Green: Band_2 Selection »
M Blue Band_3

Label Features

Edit Features b

47 Convert Features to Graphics...
Convert Symbolegy to Representation..,
Data »
Save As Layer File...

W’ Create Layer Package.

I [*" Properties... I

‘ | Layer Properties

Display the properties of this layer
|

3. Setelah layer properties muncul, Features - Single Symbol: untuk simbolisasi satu
jenis saja tanpa pengklasifikasian. Categories — Unique Values digunakan untuk
klasifikasi simbolisasi menjadi beberapa jenis. Pilih field yang akan dijadikan sebagai
dasar simbolisasi, misalnya pada field KAPASITAS (KAPAS).
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Layer Properties b 4

General Source Selection Display Symboigy Fields Definion Query Labels Joins & Relates Tme  HTML Popup
Show:

== biliiy using unique values of one field. Import...
Catoodhres ‘ veie o Rarp
e il itk i_: : "
Uniqe valies. mary | [Mm_Det_Das "
Match to symbols in a1 Thn_Dat
Guantities || |Propins b Court
Charts it cther vahues
Mutiple Atlributes ‘ Biae
Hapasitas
Kt T
(| | Koord_x
Kgard_‘(

< > |

Klik Add All Values atau Add Value untuk memilih simbol yang akan dimunculkan pada
peta. Klik salah satu value yang muncul, misalnya < 20 liter perdetik. Symbol
Selector akan muncul dan berfungsi untuk mengganti jenis simbol, pilih simbol sesuai
kebutuhan. Simbolisasi lebih lanjut dapat dilakukan dengan Edit Symbol. Silakan
mencoba berbagai pilihan simbol dan menentukan berbagai parameter simbol seperti
ukuran, sudut, warna, dan parameter lainnya pada Symbol Property Editor.

Layer Properties » |

Generd Source Selecion Display Symbology Fields Defintion Query Labels  Joins & Relates Time  HTML Popup
Show:

Fadie | Draw categories using unique values of one field. import._.

Categories | Vaue Field Color Ramp

- Urique values | lAm v| &
thueval.les.mawl - -

+ Ma&mmbnav T -

Quantities | Symbol  Value Label Count

Charts [J* <lothervaluess <all other values> i}

Muiltiple Attributes: <Heading> AM 157
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5. Setelah selesai melakukan pengaturan symbol - Klik OK.

Q@ Untitied - ArcMap

File Edit View Bookmares lnset Selechon Gecproceising Customite  Windows Help
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3.2.2. Simbolisasi Garis

{m] »
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5 Snapping = ‘|
=
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109,281 -5,969 Deamal Degrees

S N

Aege: (W00

Calor

Sebelum melakukan simbolisasi, layer data yang akan disimbolisasi harus dimasukkan

dulu ke dalam ArcMap Document yang akan diedit. Simbolisasi dilakukan dengan langkah-langkah

sebagai berikut:

1. Buka layer Ciawi_Jalan.shp
2. Klik kanan pada layer yang akan dilakukan simbolisasi, pilih Properties
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Cionvert Symbiagy ta Repretentation.

3. Setelah layer properties muncul, ganti simbol dengan melakukan klik pada Symbol.

Layer Properties

Jors | Fislsies Time
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Show
= l fevatvres, mirg ther s wymbol
= ®

Cwditons
Chasts ARt =
Multiple Afisibades

Legend

Latel sppearing next to e symbol  teble of contents:

%’Lﬂ% Desrpon,

Q kb desciohon aea g et s £ Syl 1 o n ey

*
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Cancel

Symbol Selector akan muncul dan berfungsi untuk mengganti jenis simbol, pilih simbol

yang sesuai dan merupakan representasi dari layer. Simbolisasi lebih lanjut dapat
dilakukan dengan Edit Symbol. Silakan mencoba berbagai pilihan simbol dan
menentukan berbagai parameter simbol seperti ukuran, sudut, warna, dan parameter

lainnya pada Symbol Property Editor.

[ —
i Symbo! Property Editor
1.€ mere tc searh v p i, Current Symbol Phasiions
Sewch: @ AlStyles OReferenced Sires
Dell -
P
panta Sl u- & — A
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|
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Colgr -. Widh: | 1300072

e Cops: Line Jons
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Round ) Round

) Sauiare ) Bl

[
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5. Setelah selesai mengatur symbol > Klik OK.

file Edit View Bookmacks Insert Selection Geoprocessing Customae Windows Hel
= L) B %0 0. 12775 I EEEEn =,
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5 B CIaWLF A EJI
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v
< > |Ais| & a < >

3.2.3. Simbolisasi Luasan

Sebelum melakukan simbolisasi, layer data yang akan disimbolisasi harus dimasukkan
dulu ke dalam ArcMap Document yang akan diedit. Simbolisasi dilakukan dengan langkah-langkah

sebagai berikut:

1. Buka layer daerah_irigasi.shp

2. Klik kanan pada layer yang akan dilakukan simbolisasi, pilih Properties

| Table Of Contents W P ~
ElaocE & F ol
i O JawsBarat_AirHinum
= O JawaBarat_lalanMasiona) | /-

5 [7 JAWABARAT lalen_Masi| P

g [hsLe
] & Copy
5 B ClAWLGE X Remove
RGE |
o R:; T | Open Attribute Table
) Green: [Ilnl‘l__.’ Jgins and Relates
M Blue Bond3 |y Zoom Tolayer

Vigibde Scale Range »
Use Symibel Levels |
Sefection N
Lakal Featres

Edit Features v

%o Convert Featuresto Graphics... |
Convent Symboleqy to Reprecsntstion...

X Data "
p— Save A5 LayerFile..,
simbol sepel L
Properies...
s [E  Engiish fUnited Kin i el et

i Despiay the propertaes of this br

3. Setelah layer properties muncul, ganti simbol dengan melakukan klik pada Symbol.
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Symbol Selector akan muncul dan berfungsi untuk mengganti jenis simbol, pilih simbol
yang sesuai dan merupakan representasi dari layer. Simbolisasi lebih lanjut dapat
dilakukan dengan Edit Symbol. Silakan mencoba berbagai pilihan simbol dan
menentukan berbagai parameter simbol seperti ukuran, sudut, warna, dan parameter

lainnya pada Symbol Property Editor.
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TUTORIAL 4

Geovisualisasi 3 Dimensi

Model 3 Dimensi merupakan salah satu cara untuk memvisualisasikan data — data yang
memiliki referensi tinggi, seperti Digital Elevation Model (DEM). DEM merupakan data digital yang
menggambarkan geometri dari bentuk permukaan bumi yang bersumber dari foto udara stereo,
citra satelit stereo, data pengukuran dilapangan, garis kontur pada peta topografi ataupun citra
radar.

4.1. Pembentukan Hillshade dan TIN

Model Hillshade dan Model Triangulated Irrigular Network (TIN) yang merupakan turunan
dari DEM dapat digunakan untuk geovisualisasi 3 Dimensi dengan menggunakan ArcMap dan
ArcScene.

4.1.1. Pembentukan Hillshade

Pembentukan model Hillshade dari data DEM dapat dilakukan dengan langkah-langkah
sebagai berikut:

1. Add data ciawidem_utm.tiff
2. Klik ArcToolbox -> 3D Analyst Tools -> Raster Surface, Double Klik pada Hillshade
= & Raster Surface

#, Aspect

Contour

Contour List
Contour with Barriers
Curvature

Cut Fill

#, Slope

L T N N Y

3. Pilih Input Raster: ciawidem_utm.tiff, Output Raster: hillshade, arahkan ke folder
penyimpanan. Klik OK

Hillshade = =}

Output raster

The output hellshada rastar
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Hint ; secara default, Azimuth diset pada angka 315° dan altitude pada 45°

4.1.2. Pembentukan TIN
Pembentukan model TIN dari data DEM dapat dilakukan dengan langkah-langkah sebagai
berikut:

1. Add data ciawidem_utm.tiff
2. Klik ArcToolbox > 3D Analyst Tools > Conversion, Double Klik pada Raster to TIN

=) & Conversion
71 & From Feature Class
7 & From File
i) & From LAS Dataset
=) & From Raster
#., Raster Domain
#_ Raster to Multipoint
I #_ Rasterto TIN I

3. Pilib Input Raster: ciawidem_utm.tiff, biarkan pengaturan lainnya, dan Cutput Raster: tin,
arahkan ke folder penyimpanan. Klik OK

#, Raster e THH - o »
Trpt Raster Raster to TIN
[Clawdern_amst 7] B
Crmarts @ raster to & triangulated imaguilar
> network (TN) dataset
o=
Mo tuemter of Ponts {nosonal)
500000
2 Facter {mpfional)
1
o= Canesl Evaranmands. . o Haske Haly Tond Hales

54



el

eor gl [

‘|mEies <
Orswing~ K - +2 - A~ | o vnluA-‘r-i.-,i

TUSEE 405 WIERIS6 56 Mumers

4.2. Geovisualisasi 3 Dimensi di ArcMap

Model Hillshade dan TIN dapat dikombinasikan dengan data lainnya, seperti DEM, data
batas administrasi, atau data jalan. Untuk mengkombinasikan tampilan data di ArcMap, lakukan
langkah — langkah sebagai berikut:

1. Masukkan data DEM, Hillshade, TIN, dan Jalan yang hendak ditampilkan dengan klik
kanan pada Layers - Add Data.

Hint: untuk memasukkan lebih dari 1 layer, tekan Shift atau Ctrl

2. Letakkan Layer Hillshade (ciawidemhs) dan TIN (ciawidemtin) pada urutan paling bawah,
disusul oleh layer DEM (ciawidem) dan jalan diatasnya.

3. Aktifkan layer DEM (ciawidem), Hillshade (ciawidem hs) dan TIN (ciawidem tin).

4. Atur simbolisasi layer DEM dengan Klik Kanan - Layer Properties > Klik Tab

Display > Set Transparency 50%
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5. Simbolisasi layer-layer data tersebut sehingga mendapatkan tampilan seperti dibawah ini:

6. Simpan tampilan yang telah dibuat dengan klik File > Save As

4.3. Geovisualisasi 3 Dimensi di ArcScene

Data yang dimiliki dapat ditampilkan dalam ArcScene dengan syarat diantara data yang
dimiliki terdapat model data TIN yang digunakan sebagai dasar (base) ketinggian dari layer —
layer data lainnya. Untuk menampilkan data — data yang telah dimiliki ke dalam ArcScene, lakukan
langkah — langkah sebagai berikut:
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Buka aplikasi ArcScene dari Start Menu > ArcGIS - ArcScene

2. Masukkan data yang akan ditampilkan di ArcScene dengan Klik Kanan > Add Data,
browse ke Folder tempat penyimpanan data dan pilih layer data yang akan ditampilkan
- Klik Add

3. Untuk membuat tampilan layer data memiliki ketinggian, Klik Kanan > Klik Base
Height tab > Klik > Floating on a costum surface Pilih layer TIN: ciawidemtin

| Layer Properties *

Gonemnl  Source  Bxtent  Display  Symbology  Base Heights Tme  Rendoring

Elevation fram surfaces
() Mo elevation vaiues from a surface

(@) Floating on & custom surface:

[c:wiorkipJ08 120 160800 1AW v|

Faste Resiton. ..

Elevation from features

Na feature based heghts
Lise glevaton values n e layer's features
Factor to corwert layer elevation values to soere units: oustam w 1,0000 |
Use a constant value or expression:
i} B

Layer offset
Add a constant elevaton offset in scene units:

t g8l base 11

4. Atur simbolisasi layer — layer data sehingga tampak menarik.

5. Untuk mengatur navigasi selama memvisualisasikan data di ArcScene, kita dapat
menggunakan tools Navigate, Fly, Center on Target, Zoom to Target, Set Observer

e~o @@ RANOE- - x OF M = TG

57



TUTORIAL 5

Pemanfaatan UAV Untuk Pemetaan Bencana

Data hasil pengolahan UAV seperti DEM (DSM dan DTM) dan ortofoto dapat bermanfaat
untuk berbagai bidang aplikasi, salah satunya dalam bidang kebencanaan. Dalam bidang
kebencanaan sendiri, penggunaan UAV tidak hanya bermanfaat pada saat setelah bencana
(tanggap darurat, rehabilitas dan rekonstruksi) tetapi pada saat pra bencana (mitigasi). Berikut
ini disajikan beberapa contoh aplikasi pemetaan berbasis UAV dalam penanganan bencana,
dengan lokasi studi di sekitar Kota Palu, Sulawesi Tengah, yang pada bulan September 2018
mengalami bencana Gempabumi, Tsunami dan Likuifaksi.

5.1 Pemetaan Kerusakan Bangunan/Permukiman

Salah satu kemanfaatan utama data ortofoto dari survei UAV adalah untuk pemetaan
kerusakan infrastruktur dan permukiman pasca bencana. Kebutuhan data dan informasi jumlah
rumah rusak adalah salah satu data dasar (baseline data) yang dapat bermanfaat dalam kegiatan
tanggap darurat dan rehabilitasi rekonstruksi. Ketersediaan Ortofoto dapat mempercepat proses
pendataan rumah rusak/hilang/roboh, terlebih apabila dilengkapi dengan ketersediaan citra
satelit/ortofoto kondisi sebelum bencana.

Berikut ini diuraikan contoh langkah — langkah teknis pemanfaatan ortofoto dari UAV
untuk perhitungan cepat kerusakan rumah di sebuah wilayah (desa) di Kota Palu.

1. Buka perangkat lunak  ArcGIS ArcMap, kemudian tambahkan data
Ortofoto_Petobo_Oktober2018.tif dan citra_Petobo_April2018.tif. Ubah urutan
tampilan dimulai dari citra satelit terlebih dahulu, baru diatasnya ditampilkan ortofoto.

2. Buat data layer permukiman dengan jenis data “Point”, dengan mengacu pada teknik
digitasi obyek titik sebagaimana telah diuraikan pada sub bab 3.1.1. Selanjutnya
tambahkan field keterangan di data atribut, dengan jumlah characters 50.

3. Amati citra sebelum bencana dan ortofoto setelah bencana, kemudian digitasi rumah
yang masih utuh dan rumah yang hilang/rusak, berikan keterangan untuk setiap jenis
rumah.

4. Contoh hasil pemetaan disajikan pada gambar di bawah ini.
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5. Jumlah rumah roboh dan utuh dapat dihitung sebagai berikut:

a.

Buka Tabel atribut dari layer rumah rusak, kemudian Add Field baru dengan nama

field “count”, type field: small integer.

Pilih semua baris data di dalam tabel menggunakan perintah: Tahan tombol Cntrl +

A. seluruh baris akan terpilih, ditandai dengan warna biru.

Kemudian klik kanan nama field/kolom “Count”, kemudian pilih field Calculator. Isikan

angka 1 pada kolom yang tersedia di field calculator. Klik OK.
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d. Kolom Count akan terisi angka 1 untuk setiap baris data. Selanjutkan klik kanan nama
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field/kolom “Status”, pilih Summarize. Cari kolom Count, kemudian expand, pilih
Sum. Operasi summarize akan membuat tabel baru.

T
Summanze X

| Summarize creabes & new table cortairing ane mcord for sach unioue value
of the sslected field. along with statistics summanizing any of the other fields

| 1. Sedect a fisld to summanize:
[éﬂu& -u.

2 (Choose one or more gummary satistics to be ncluded in the
{able:

v
3 Specify output tabie:
i:-\wn.a.p.mm1wrr.n_al.lsmsuxnﬂ\ek_wn¢=| =

Summanze on the selected reconds only

e. Buka Tabel summarize yang dihasilkan, kolom Sum Count akan memberikan
informasi jumlah rumah/bangunan sesuai dengan tingkat kerusakannya. Anda juga

dapat membuat grafiknya apabila diperlukan.

Jumlah Rumah/Bangunan Rusak

1219 Kemungkinan Rusak

343 Robah | 1 349 Roboh

&
E
=

129 Elunl

o838 EEEEEENEEBEEEEE

Kemungkinan Rusak ~ Roboh Rusak tuh
Tingkat Kerusakan

5.2 Pemetaan Area Longsor Jalan

Untuk studi kasus bencana tanah longsor/gerakan tanah, ortofoto hasil UAV dapat
dimanfaatkan untuk pemetaan area terdampak longsor, bidang longsor, dan infrastruktur
terdampak longsor. Sementara hasil DTM dan DSM dapat digunakan untuk memperkirakan antara
lain volume material longsor, estimasi volume galian dan timbunan ( cut and fill). Berikut ini contoh
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langkah

longsor.
1.
2.

- langkah penerapan data ortofoto untuk pemetaan infrastruktur terdampak bencana

Buka perangkat lunak ArcGIS ArcMap, kemudian tambahkan data Ortofoto_longsor.tif.
Buat data shapefile baru dengan jenis polygon, sistem koordinat yang digunakan adalah
UTM Zona 50S, berikan nama: area_terdampak_longsor.shp, dengan mengacu
pada prosedur pembuatan layer polygon/luasan pada sub bab 3.1.3.

Lakukan digitasi area longsor menggunakan editor toolbar. Contoh hasil seperti gambar
di bawah ini.

Selanjutnya, buat data shapefile baru dengan jenis polyline, sistem koordinat yang
digunakan adalah UTM Zona 50S, untuk kolom atribut, buat field baru dengan nama field
“keterangan” dengan tipe text: 50 characters, berikan nama output file:
ruas_jalan_terdampak_longsor.shp, dengan mengacu pada prosedur pembuatan
layer polyline/garis pada sub bab 3.1.2.

Lakukan digitasi jalan yang terkena longsor dan tidak terkena longsor menggunakan
editor toolbar. Contoh hasil seperti gambar di bawah ini.
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6. Hitung panjang jalan yang terkena longsor menggunakan operasi calculate geometry.
Operasi calculate geometry dapat dilakukan dengan cara membuka tabel atribut dari
layer aktif (klik kanan nama layer di Table of Content > Open Attribute Table),
kemudian buat field baru dari Menu Table > Add Field, isikan nama kolom: panjang,
dengan type kolom: float. Selanjutnya, klik kanan nama kolom ‘panjang * yang telah
dibuat, pilih calculate geometry, dan pilih length, tentukan juga unit yang akan
digunakan untuk penghitungan panjang jalan (umumnya satuan yang digunakan adalah
meter). Contoh hasil calculate geometry seperti di bawah ini.
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5.3 Pemetaan Perubahan Garis Pantai Akibat Tsunami

Terkait dengan aplikasi bencana tsunami, ortofoto dan DEM dapat dimanfaatkan untuk
pemodelan area terdampak, kerusakan infrastruktur, rekonstruksi gelombang tsunami, dan
berbagai aplikasi lainnya. Sebagai contoh, berikut ini disajikan langkah — langkah pemetaan
perubahan garis pantai akibat kejadian tsunami.

1. Buka perangkat Iunak ArcGIS ArcMap, kemudian tambahkan data
Ortofoto_Talise_oktober2018.tif dan citra_Talise_April2018.tif. Ubah urutan
tampilan dimulai dari citra satelit terlebih dahulu, baru diatasnya ditampilkan ortofoto.

2. Buat layer garis pantai sebelum terjadinya bencana (mengacu pada citra satelit
bulan April 2018), menggunakan prosedur pembuatan polyline dan editing polyline di
sub bab 3.1.2, kemudian lanjutkan dengan garis pantai setelah terjadinya bencana
(mengacu pada ortofoto bulan Oktober 2018).

3. Lanjutkan dengan data lain seperti, pengaman pantai yang mengalami kerusakan, area
terdampak, bangunan dan fasilitas umum kawasan pesisir yang mengalami kerusakan.

62



4. Contoh hasil seperti ditunjukkan pada Gambar di bawah ini.

Legend
s GarisPantai_PascaTsunami

— (GarisPantai_PraTsunami
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